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SP - Simple Portfolio

SP Einfaches Portfolio — Was ist dabei

Funktionsreiche Joomla Portfolio-Erweiterung

Die Erweiterung SP Simple Portfolioist eine kostenlose Joomla! Erweiterung, die
entwickeltwurde, um Medienportfolio-Funktionen (Bild oder Video) in Inrer CMS-Website
zu erstellen. Ermoglicht Designern, Kunstlern und Fotografen, ein sehr modernes und
herausragendes filterbares Portfolio zu erstellen, zu verwalten und zu veroffentlichen.
Prasentieren Sie lhre besten Arbeiten Kunden und Neukunden auf attraktive,
professionelle und reaktionsschnelle Weise. Es ist sehr einfach und schnell,
atemberaubende Portfolios zu erstellen und sie in lhre Joomla! Platz. Das filterbare
Portfolio - Wenn ein bestimmtes Tag ausgewahlt wird, wird die Liste der Projekte sofort
mit einer neuen Liste von Projekten aus dem ausgewahlten Tag neu generiert.

Hauptmerkmale

Paket enthalt Komponente und Modul. Es kann kostenlos heruntergeladen und
verwendet werden, auch in kommerziellen Projekten. Einfach zu bedienende Losung, die
keine Programmierkenntnisse erfordert. Layout-Einstellungen (Standard | Galerie mit
oder ohne Abstand zwischen den Bildern)

Miniaturansichten zur Auswahl

Quadratisch, Rechteckig oder Mauerwerk. Sie konnen jedem Element Details
hinzufligen, wie z. B.: Screenshots (Miniaturansicht und Vollbild), einen Titel, einen Alias,
eine Beschreibung, eine URL und wahlen Sie den Status, die Sprache und die
Zugriffsebene aus. Basierend auf dem Tags-System. Unterstutzung von YouTube- und
Vimeo-Videos (fligen Sie einfach |hren Videolink ein), Unterstitzung von Bildern und
Fotos (JPG, PNG, GIF). Anzuzeigende Spalten : 2, 3 oder 4. Sie konnen die Anzahl der
Elemente festlegen, die pro Seite angezeigt werden sollen. Sie kénnen lhre Bilder
hochladen oder lhren Videolink von YouTube und Vimeo einfugen.

e Gefilterte Elemente mithilfe von Animationen

e Lightbox-Effekt

e (CSS3-Animationseffekt auf Miniaturansichten

e Mehrsprachige Unterstutzung

e Suchmaschinenfreundliche URLs

e Responsives Layout, was bedeutet, dass |hr Portfolio aufjedem Gerat gut aussieht

e Moderner Look & Feeling
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Erste Schritte

Einleitung

Logo Banner Print Vigeo

{ zoom
\vv -

Portfolio item 11

Logo, Print

SP Simple Portfolio ist eine leistungsstarke Joomla-Erweiterung, die entwickelt wurde,
um nahtlose Medienportfolio-Funktionen fur Websites bereitzustellen. Diese
Erweiterung ist auf Designer, Kinstler und Fotografen zugeschnitten und ermoglicht es
Benutzern, atemberaubende filterbare Portfolios mit Leichtigkeit zu erstellen, zu
verwalten und zu prasentieren.

SP Simple Portfolio bietet eine Reihe von Funktionen, um lhre Arbeit professionell und
reaktionsschnell zu prasentieren, einschlieBlich Unterstitzung fur Bilder und Videos.
Nutzer kdnnen schnell moderne Portfolios erstellen, Projekte nach Tags filtern und sofort
relevante Inhalte basierend auf der ausgewahlten Kategorie anzeigen. Diese Erweiterung
hilft lhnen, lhre besten Arbeiten attraktiv zu prasentieren, und ist damit ideal, um
potenzielle Kunden zu binden und lhre kreativen Leistungen zu prasentieren.

Es ist ein eigenstandiges Joomla! Komponente (mit Modulen), die Sie auch mit den
anderen (JoomShaper) Templates verwenden konnen.

Technische Anforderungen

Da es sich um eine Erweiterung flr Joomla handelt, wird dringend empfohlen, immer die
neueste stabile Version von Joomla zu verwenden, um Kompatibilitat, Sicherheit und
Fehlerbehebungen zu gewahrleisten. Diese Komponente funktioniert nahtlos mit Joomla
5.x,4.x und 3.x.

e PHP: 7.4 (mindestens) oder 8.x (empfohlen)
¢ MySQL: 5.6 (mindestens) oder 5.7, 8.x (empfohlen)

e Server: 64-Bit-Server erforderlich. PHP 7+ und 8 bieten volle 64-Bit-
Unterstltzung, einschlieBlich nativer 64-Bit-Ganzzahlen, LFS und erhohter
Speicherlimits.

e PHP upload_max_filesize = 3M oder mehr.

Browser-Empfehlungen:
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o Flrdie beste Erfahrung beim Bearbeiten von Inhalten verwenden Sie die neuesten
Versionen moderner Browser wie Safari, Chrome, Firefox, Opera, MS
Edge oder Brave.

Anmerkung: Die Unterstltzung fur Internet Explorer ist eingeschrankt.

Sehen Sie sich auch die grundlegenden Anforderungen von Joomla 4.x an.

So installieren Sie SP Simple Portfolio

Der Installationsprozess fur Joomla-Erweiterungen ist derselbe wie fur die Vorlagen.
Beginnen Sie mit dem Herunterladen des Erweiterungspakets von der JoomShaper-
Website. Es enthalt die Komponente im Inneren.

Navigieren Sie in lhrem Joomla-Dashboard zum Abschnitt Systeme > Installation >
Erweiterungen. Wahlen Sie die Registerkarte Paketdatei hochladen aus. Jetzt kdnnen Sie
die Zip-Datei der SP Simple Portfolio-Erweiterung per Drag & Drop verschieben oder Ihr
Gerat durchsuchen, um die Zip-Datei hochzuladen. Die Erweiterung wird dann
automatisch installiert.

Nach der Installation kénnen Sie die SP Simple Portfolio-Komponente in den
Komponenten lhres Joomla-Dashboards finden.

Kernfunktionen von SP Simple Portfolio

Artikel

B Joomiar’ & SP Simple Portfolio: ltems M4z [ TekeaTouw v | M4 PostinstallationMessages | [ Kreatva | @ UserMens v

@ Toggle Menu

+ New @ ] 2} & Options
4 Home Dashboard

B Content Search n Filter Options v  |\Clear Sort Table By: v 20 v

i= Menus .

# T - Image Title Access ¢ Author $ Date Created ¢ Language $ Status ¢ Ds
Banners = ‘ Smart Home Automation Atiss: Public 2023-08-29 Al @ 12
e Y
EasyStore = Public 2023-08-29 Al @ 1
News Feeds
Search

= Public 2023-08-29 All @ 14
Smart Search
SP Booking
SP Easy Image Gallery = v Public 20230829 A @ 13
N
SP LMS
SP Page Builder Pro = Public 2023.08-29 Al @ 16
SP Polls
SP Simple Portfolio
= ﬂ—l Dynamic Portfolio Alias: dynamicp  Public 2023:08-29 Al @ 17
A ortfolio
A A

Tags: Advertising
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Sie konnen auf die Elemente aus dem Joomla-Backend > Komponenten > SP Simple
Portfolio > Items zugreifen. Um einen neuen Artikel zu erstellen, klicken Sie
auf "+Neu". Sie konnen auch bereits vorhandene Elemente bearbeiten, indem Sie einfach
daraufklicken.

Unabhangig davon, ob Sie ein neues Element hinzufligen oder ein vorhandenes Element
bearbeiten, werden Ihnen die folgenden Optionen angezeigt:

B B SP Simple Portfolio: Add New Item Rasz (2 Kt
B Save B Save &Close X Close

Title * Client

Client Avatar (optional)
Image *

Thumbnail (optional)

Category

m Select Category v
Select a category from the list

Titel: Geben Sie dem Element einen Namen.

Alias: Der Alias wird bei der Erstellung der URL (Website-Adresse) fur die Detailseite
verwendet. StandardmaBig verwendet die Komponente den Titel, um den Alias (mit
Anderungen) zu erstellen, es sei denn, Sie geben selbst einen Alias ein. Joomla wird den
Alias in Kleinbuchstaben schreiben, Leerzeichen durch Bindestriche ersetzen und alle
Zeichen entfernen, die nicht akzeptiert werden konnen.

Bild: Um ein Bild fur einen Artikel auszuwahlen, konnen Sie vorhandene Bilder verwenden
oder ein neues Bild hochladen. Die empfohlene BildgroBe: betragt 1170px x 800px. Wenn
Sie jedoch nur kleinere haben, kdnnen Sie diese auch verwenden.

Daumennagel: Sie kénnen ein Miniaturbild auswahlen, anstatt ein automatisch
generiertes Miniaturbild zu verwenden. Dies ist ein optionales Feld.
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a8 save B Saves

mple Portfolio

(

Status
Video URL
Published v

Language

Al v

Access

Public v

¥
L=
¢
1
I
I
i

Created Date

Created By

@ Toggle Editor

Video-URL: Portfolio-Elemente kdénnen Bilder und YouTube- oder Vimeo-Videoclips
enthalten. Geben Sie einfach |hre Video-URL in dieses Feld ein. Lassen Sie dieses Feld
leer, wenn das Video nicht bendtigt wird.

URL-Adresse: Jedes Element kann einen eigenen Link enthalten. Lassen Sie dieses Feld
leer, wenn Sie die Projekt-URL nicht anzeigen mochten.

Beschreibung: In diesem Feld kdnnen Sie eine Beschreibung oder sogar zuséatzliche
Bilder hinzufuigen, die auf der Artikeldetailseite unter dem Hauptbild angezeigt werden.

Kunde: In diesem Feld kdnnen Sie den Kundennamen fur lhr Projekt einfugen. Wenn Sie
keinen Client haben, kdnnen Sie das Feld leer lassen, da es optional ist.

Client-Avatar: Sie konnen ein Bild oder Logo fur lhren Kunden auswahlen. Dies ist auch
ein optionales Feld.

Schilder: Alle Artikel kbnnen mit Tags versehen werden. Sobald Sie bei drei Buchstaben
angekommen sind, sehen Sie vorgeschlagene Tags, die bereits vorhanden sind. Der
Vorteil dieser LOsung besteht darin, dass jedem Artikel mehrere Tags zugewiesen werden
konnen. Dasselbe Tag kann auf viele verschiedene Inhaltselemente in einem Portfolio
angewendet werden. Tags werden verwendet, um Portfolioelemente zu filtern.

Kategorie: Ahnlich wie bei Tags kénnen Sie auch die Kategorie fiir das Element festlegen.

Status: Sie kdnnen den Sprecher ein- oder ausblenden, indem Sie seinen Status von
Veroffentlicht/Unverdffentlicht andern.

Sprache: Gibt die Sprache flr diese Kategorie an. Wenn lhre Website mehrsprachig ist,
konnen Sie die Kategorie einer bestimmten Sprache zuweisen. Wenn es in allen Sprachen
verflugbar sein soll, kdbnnen Sie es auf "Alle" setzen.
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Zugang: Steuert, welche Benutzergruppen diese Kategorie anzeigen kénnen. Sie kdnnen
den Zugriff auf bestimmte Kategorien basierend auf Benutzerberechtigungen
einschranken. Sie kdbnnen wahlen zwischen

« Offentlich

o Gast

e Registriert
e Spezial

e SuperUser

Erstellungsdatum: Wenn Sie auf das Kalendersymbol klicken, kdnnen Sie ein anderes
Datum fur das Erstellungsdatum festlegen, aber wenn Sie es leer lassen, wird
automatisch das aktuelle Datum verwendet, wenn die Lektion erstellt wird.

Erstellt von: Die Person, die den Artikel erstellt, wird diesem Feld automatisch
zugewiesen, sobald die Lektion erstellt wurde, aber ein Administrator (Superuser) kann
den Benutzer jederzeit andern.

Kategorien

HJoomlc!‘ = SP Simple Portfolio: Categories %442 |3 TekeaTow v | M 4 PostinstallationMessages | (£ Kreatha | © UserMenu v

@ Toggle Menu

4 Home Dashboard

+ New & Options ? Help

B Content

i= Menus

¥ Components
Banners
Contacts
EasyStore

News Feeds

SP Simple Portfolio: Categories

Search There are currently no categories for this extension

SP Book
d Add a category  Learn More

SP Easy Image Gallery.

Search

SPLMS
SP Page Builder Pro
SP Polls
SP Simple Portfolio
Items
Categories
Tags

Tags

Um Kategorien zu erstellen oder zu bearbeiten, gehen Sie zum Joomla-Backend >
Komponenten > SP Simple Portfolio > Kategorien. Um einen neuen Artikel zu erstellen,
klicken Sie auf"+Neu" oder"Kategorie hinzufiigen" Sie kdnnen auch bereits
vorhandene Kategorien bearbeiten, indem Sie darauf klicken.

In den Einstellungen fur neue Kategorie erhalten Sie die folgenden Optionen:
Titel: Geben Sie den Namen der Kategorie ein.
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Alias: Sie kdnnen entweder automatisch einen Alias aus dem Titel generieren oder
manuell selbst einen eingeben. Wenn Sie mochten, dass der Alias automatisch generiert
wird, lassen Sie das Feld leer.

Zusatzlich erhalten Sie die folgenden Registerkarten und nachfolgende Optionen:

Kategorie

Bl = SPSimple Portfolio: New Category

B Save B Save&Close v X Close ? Help
Title * Alias
Auto-generate from title

The Alias will be used as part of the URL

Category Options Publishing Permissions

Description Parent
Edit Insert View Format Table Tools
- No parent - x ~
mCh‘.SConm:‘.l\ B I U & = = = = Paragraph v
Status
Published .
Access
Public v
Tags

Type or select some tags  «»

Note

0 WORDS

@ Toggle Editor

Unter Kategorie finden Sie folgende Optionen:

Beschreibung: Eine detaillierte Beschreibung der Kategorie. In diesem Textfeld kdnnen
Sie alle anderen relevanten Informationen zur Kategorie beschreiben, wobei Sie die volle
Kontrolle Uber die Schrifttypografie haben. Zu den zusatzlichen Optionen in diesem Feld
gehoren die Moglichkeit, CMS-Medien zur Beschreibung hinzuzufligen, externe
Quellcodes fur eine schnelle Bearbeitung einzufiigen und vieles mehr.

Ubergeordnet: Uber das Dropdown-Meni kénnen Sie auswéhlen, ob diese Kategorie
einer Ubergeordneten Kategorie angehoért. StandardmaBig ist diese Option auf ,,Kein
ubergeordnetes Element” eingestellt.
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Status: Sie konnen den Sprecher ein-/ausblenden, indem Sie seinen Status von
WVeroffentlicht” auf ,,Unveroffentlicht” andern.

Zugriff: Steuert, welche Benutzergruppen diese Kategorie sehen kénnen. Sie konnen den
Zugriff auf bestimmte Kategorien basierend auf Benutzerberechtigungen einschranken.
Sie konnen wahlen zwischen

e Public

Guest

Registered

Special

Super Users
Tags: Using the dropdown menu you can choose a tag for this category.
Note: Add any additional note regarding this category if applicable.

Options

Bl = SPSimple Portfolio: New Category

B Save B Save &Close v X Close ? Help

Title * Alias
Auto-generate from title

The Alias will be used as part of the URL

Category Options Publishing Permissions

Options
Layout Use Global v

Image

Image Description (Alt Text)

No Description

Decorative Image - no description required

Unter Optionen finden Sie folgende Optionen:
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Layout: Legen Sie das Layout fur diese Kategorie fest. StandardmaBig ist es auf "Use
Global" eingestellt.

Bild: Flgen Sie ein Bild hinzu, um die Kategorie darzustellen.

Bildbeschreibung (Alt-Text):In diesem Feld kénnen Sie eine zusatzliche
Beschreibung/einen alternativen Text flr das Bild angeben.

Keine Beschreibung: Wenn Sie diese Option umschalten, wird festgelegt, ob das Bild
eine Beschreibung hat oder ohne Beschreibung, d.h. ob es sich um ein "dekoratives Bild"
handelt.

Verlagswesen

Bl = SPSimple Portfolio: New Category

B save B Save&Close v X Close ? Help
Title* Alias
The Alias will be used as part of the URL
Category Options Publishing Permissions

Publishing Metadata

Created Date Meta Description

Created By Select a User
Modified Date
Keywords
Madified By
Hits 0
Author
D 0
Robots Use Global ~

Unter Veroffentlichung finden Sie zwei zusatzliche Abschnitte: einen mit dem
Namen Veroéffentlichung und den anderen mit der Bezeichnung Metadaten.

Der erste Abschnitt, Veréffentlichen, enthalt die folgenden Einstellungen:

Erstellungsdatum: Wenn Sie auf das Kalendersymbol klicken, kbnnen Sie ein anderes
Datum fur das Erstellungsdatum festlegen, aber wenn Sie es leer lassen, wird
automatisch das aktuelle Datum verwendet, wenn die Lektion erstellt wird.
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Erstellt von: Die Person, die ein Ereighis erstellt, wird diesem Feld automatisch
zugewiesen, sobald die Lektion erstellt wurde, aber ein Administrator (SuperUser) kann
den Benutzer jederzeit andern.

Anderungsdatum: In diesem Feld wird das Datum angezeigt, an dem die Kategorie
geandert wurde.

Geandert von: Dieses Feld zeigt den Benutzer an, der die Kategorie zuletzt gedndert hat.

Hits: Dieses Feld zeigt die Zugriffe des Albums bzw. die Anzahl der Klicks auf die Kategorie
an.

ID: In diesem Feld wird die Kategorie-ID angezeigt.
Der Abschnitt Metadaten enthalt die folgenden Einstellungen:

Meta-Beschreibung: Ein optionaler Absatz, der als Beschreibung der Seite in der HTML-
Ausgabe verwendet werden soll. Dies wird in der Regel in den Ergebnissen von
Suchmaschinen angezeigt.

Schliisselworter: Hierbei handelt es sich um eine optionale, durch Kommas getrennte
Liste von Schlusselwortern und/oder Phrasen, die in der HTML-Ausgabe verwendet
werden sollen.

Verfasser: Legen Sie den Autor der Kategorie fest.

Roboter: Meta-Robots sind HTML-Tags, die Suchmaschinen anweisen, wie eine
Webseite indiziert und gecrawlt werden soll, und ihre Sichtbarkeit in den
Suchergebnissen steuern. StandardmaBig ist diese Option auf "Global verwenden"
eingestellt.

Erlaubnisse

Sie konnen die Berechtigungen flr die Kategorie steuern. Dadurch wird festgelegt, wer die
Kategorie verwenden oder bearbeiten kann. Sie kdnnen zwischen Offentlich, Gast,
Manager, Administrator, Registriert, Autor, Redakteur, Herausgeber und SuperUser
wahlen.

O= schmuhl Seite 11von 19



SP - Simple Portfolio

¥ ®m SP Simple Portfolio: New Category 442 |[4 Kreativa

B Save B Save&Close Vv X Close ? Help

Title * Alias
Auto-generate from title

The Alias will be used as part of the URL.
Category Options Publishing Permissions
Permissions

» Expand for notes about setting the permissions.

_ Action Select New Setting Calculated Setting

- Guest
Create Inherited v
- Manager
pelete \ ot Atowes (nvetea)
- Administrator Inherited v
- Registered Edit )
Inherited v
- Author
7 Edit State Inherited O Not Allowed (Inherited)
- Editor
- Publisher
- Super Users
KJOOI"NC]!' B3 SP Simple Portfolio: Tags 442 | TekeaTowr v | M 4 PostinstalationMessages | [£ Keeatha | © UsecMenu v
D Togole Mend + New r} X @ Options
Home Dashboard
Content 20 v
Menus
Title [}
Components
Banners Poriraits Asss: portraits 9
Contacts Location Alias: location 8
E
sryStore Lifestyle Asas: iifestyle 7
News Feeds
Automotive Alias: aitomotive B
Search
s Search Advertising Alas: advertising 5
SP Booking Adventure Aliss: sdventure 4

SP Easy Image Gallery
SPLMS
SP Page Builder Pro

SP Polls

SP Simple Portfolio

Items
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Um Tags zu erstellen oder zu bearbeiten, gehen Sie zum Joomla-Backend >
Komponenten > SP Simple Portfolio > Kategorien. Um einen neuen Artikel zu erstellen,
klicken Sie auf "+Neu". Sie konnen auch bereits vorhandene Tags bearbeiten, indem Sie
daraufklicken.

In den Einstellungen fur "Neues Tag hinzufligen" erhalten Sie die folgenden Optionen:

Bl B SP Simple Portfolio: Add New Tag 442 | [ Kreativa
B Save B Save & Close X Close
Title *
Title
Alias Auto-generate from title

The Alias will be used as part of the URL.

Titel: Geben Sie den Namen des Tags ein.

Alias: Sie kdnnen entweder automatisch einen Alias aus dem Titel generieren oder
manuell selbst einen eingeben. Wenn Sie mochten, dass der Alias automatisch generiert
wird, lassen Sie das Feld leer.

SP Simple Portfolio — Globale Konfiguration

x_,loorﬂ!o!' # Home Dashboard M442 | % TekeaTour v | M 4 PostiostollaonMessages | [4 Kreatva | @ UserMenu v

@ Toggle Menu

When is the time to upgrade to Joomla 5? Once the extensions your site needs are compatible. Learn (4 how to use the Pre-Update Checker. X

4 Home Dashboard

Content Snooze this message for all users
Menus
Components
CJsite o5 / System e

Banners
Contacts »

& =] & @&
EasyStore Users -~ Articles - Global Checkin Cache
News Feeds
Search | —

- m
Smart Search Article Categories -+ Media Giobal Configuration
SP Booking

11

SP Easy Image Gallery e A 4 < Notifications o
SElIS Modules + Plugins
SP Page Builder Pro i S}:
SPPexs C_. Overrides are up to date. 4.4.8 Available - Update now!

EasyStore
SP Simple Portfolio
Tags e o
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Sie kdnnen die globalen Konfigurationseinstellungen anpassen, indem Sie zu Home
Dashboard > Globale Konfiguration > SP Simple Portfolio gehen. Dort finden Sie
folgende Registerkarten:

Grundlegend

m_loorn!o!' & SP Simple Portfolio: Configuration 442 |9 TekeaTour v | @ 4 PostinstolationMesssges | [Z Kreatva | @ UserMenu v

@ Toggle Menu

B Save

B Save & Close X Close

4 Home Dashboard

Content System Basic  Thumbnail  Permissions
Menus > Giobal Configuration
c i Basic
ponents Options
> Articles
» Users Remove IDs from URLs Yes n
System Remove the IDs from the URLS of this comp:

Help

> Guided Tours

> Installer

IDs von URLs entfernen: Schalten Sie diese Option um, um IDs von URLs beizubehalten
oder zu entfernen.

Daumennagel

xJoorT\IQ!' £ SP Simple Portfolio: Configuration 442 |3 TekeaTour v | M 4 PostinstolationMessages | [ Kreatva | @ UserMenu v

@ Toggle Menu

B B save B Save & Close X Close ? Help

4 Home Dashboard

‘ Content System Basic Thumbnail Permissions

i= Menus > Global Configuration

- Components Options Thumbnail
> Articles

02

e > Banners Image Crop Position Center o

Zime 2biche Selecta Frsgs ciop pobon
> Checkin

© Hep eckin
ZiCoacts Square Thumbnail 294%294

> EasyStore
S outled Set the size of square thumbnall
suided Tours

> Installer
Rectangle Thumbnail v
> Joomia! Update od 596x294
> Languages Set the size of rectangle thumbna
> Mail Templates
> Media Tower Thumbnail 294294

Reset Thumbnails Click to reset thumbnails

Click this button t¢

t all thumbnails

> Plugins

Position des Bildausschnitts: Wahlen Sie eine Position fur den Bildzuschnitt aus.
Wahlen Sie zwischen "Mitte", "Oben rechts" und "Oben links".

Quadratische Miniaturansicht: Legen Sie die GroBe der quadratischen Miniaturansicht
in diesem Feld fest. StandardmaBig ist sie auf 294x294 eingestellt.

Rechteck-Miniaturansicht: Legen Sie die GroBe der rechteckigen Miniaturansicht in
diesem Feld fest. Die Standardabmessungen sind 596 x 294.
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Turm-Miniaturansicht: In diesem Feld konnen Sie die GroBe der Miniaturansicht des
Turms festlegen. StandardmaBig ist sie auf 294X294 eingestellt.

Miniaturansichten zuriicksetzen: Wahlen Sie diese Schaltflache, um alle
Miniaturansichten zuruckzusetzen.

Erlaubnisse

B £ SP Simple Portfolio: Configuration M442 |3 TekeaTour v M 4 PostinstallotionMessages [ Kreativa @ UserMenu v

Toggle Menu
99 B Save B Save & Close X Close ? Help
Home Dashboard
Content System Basic ~ Thumbnail ~ Permissions
= Menus > Global

Configuration S
Permissions
Components

Options
» Users > Articles @ Permissions for this component unless they are changed for a specific item.
> Banners
System i
> Cache
Help » Check-in » Expand for notes about setting the permissions
> Contacts
> EasyStore
> Guided Tours Action Select New Setting Calculated Setting
> Installer - Guest
> Joomla! Update Configuie ACL Inherited v ot ANcwml (wherey
-~ Manager & Options
> Languages
> Mail Templates - Administrator Access Inherited v [ Not Allowed (inherited) |
> Media Administration
- i Interface
> Menus Registered
S 3 : Mot Allowed (ihartted)|
Author Create inherited | Not Allowed (Inherited)
> Modules
e T o o i
Associations Inherited v
- Publisher
> News Feeds .
> Plugins - Super Users Edit Inherited v Nt ARowed (lharsaely
> Post-installation
Messages 3 "
EditOwn Inherited v/
> Privacy
> Redirects et
it State Not Allowed (Inherfted)
> Scheduled Tasks Inherited v

> Search
> Smart Search
> SP Bocking

> SP Easy Image

Gallery
> SPLMS
> SP Page Builder Pro

> SPPolls

> SP Simple Portfolio

> Tags
> Templates
> User Actions Log

> Users

Sie koénnen die globalen Berechtigungen fur die Kategorie steuern. Dadurch wird
festgelegt, wer die Kategorie verwenden oder bearbeiten kann. Sie kdnnen zwischen
Offentlich, Gast, Manager, Administrator, Registriert, Autor, Redakteur, Herausgeber und
SuperUser wahlen.
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SP Simple Portfolio Items als Menupunkte zuordnen

Mit dem nativen Menimanager von Joomla kdnnen Sie verschiedene SP Simple Portfolio-
Komponenten, wie z. B. Medienelemente, Kategorien oder Tags, als Menupunkte
zuweisen. Auf diese Weise kdonnen Sie bestimmte Portfolioinhalte auf lhrer Website
einfach organisieren und anzeigen, sodass Besucher problemlos durch lhre Arbeit
navigieren konnen. Unabhangig davon, ob Sie einzelne Artikel oder gefilterte Kategorien
prasentieren, haben Sie die volle Kontrolle dartber, wie lhr Portfolio prasentiert wird, und
sorgen so fur eine saubere und professionelle Darstellung.

So erstellen Sie einen MenUtpunkt, um die Angebote von SP Simple Portfolio anzuzeigen

B :i= Menus: Edit Item

o
o
e
)
z
=)

8 Save B Save&Close Vv x

Title * Alias

Portfolio portfolic

The Alias will be used as part of the URL

Details SP Simple Portfolic Settings Link Type Page Display Metadata Page Title Medule Assignment

Menu Item Type * Default m Menu *
Main Menu v

Link index.php?option=com_spsimpleportfolio&view=items

Parent Item

Target Window Parent N
- No parent - x NV

Template Style - Use Default - Ve Ordering

Accomodations v

Status

Default Page

No

Greifen Sie auf den Menii-Manager zu

Navigieren Sie in lhrem Joomla Admin Dashboard zu Meniis > Hauptmenu > +Neu. Sie
gelangen zum Formular zum Anlegen eines neuen Menupunktes.

Fligen Sie einen Titel hinzu und wéahlen Sie ein Menii aus

Geben Sie einen Titel fur den neuen MenuUpunkt ein (in diesem Fall Standard). Wahlen Sie
dann das entsprechende Menu aus, in dem dieses Element angezeigt werden soll, z. B.
das Hauptmenu.

Wahlen Sie den Typ des Menlielements
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Zusatzliche Tipps
So verstecken Sie: Datum, Tags und die Schaltflache "Projekt anzeigen"

Um diesen Block auszublenden, mussen Sie benutzerdefiniertes CSS verwenden:

.sp-simpleportfolio .sp-simpleportfolio-meta {display: none; width:0%;}

.Sp-simpleportfolio .sp-simpleportfolio-description {
vidth: 100%; float: none;}

.sp-simpleportfolio .sp-simpleportfolio-meta {display: none; width:0%;}
.sp-simpleportfolio .sp-simpleportfolio-description {

width: 100%; float: none;}
So verstecken Sie nur Datum und Tags

Wenn Sie sich entschieden haben, nur die Datums- und Tag-Blécke auszublenden,
mussen Sie auch benutzerdefiniertes CSS verwenden:

simpleportfolio-created,

sp-simpleportfolio-tags {display: none;}

o

.sp-simpleportfolio-created,

sp-simpleportfolio-tags {display: none;}
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Menu ltem Type

5P Booking

5P Easy Image Gallery

SPLMS

SP Page Builder

SP Simple Portfolio

Default

System Links

Tags

Users

Wrapper

Um einen SP Simple Portfolio-Eintrag als "Menuelementtyp" auszuwahlen, klicken Sie
auf Auswahlen. Eine Liste der verfligbaren Elementtypen wird angezeigt. Scrollen Sie
nach unten und finden Sie SP Simple Portfolio in der Liste.

Wabhlen Sie den anzuzeigenden Inhalt aus

Nachdem Sie SP Simple Portfolio ausgewahlt haben, wird lhnen die Option ,,Standard*
angezeigt. Mit dieser Funktion kénnen Sie die Anzeige lhres Portfolios kuratieren und
anpassen und so sicherstellen, dass Ihre Arbeit Gbersichtlich und optisch ansprechend
angezeigt wird.Speichern Sie lhren Menupunkt

Nachdem Sie den Inhaltstyp ausgewahlt haben, klicken Sie auf Speichern und SchlieBen.
Ihr neuer Menlpunkt zeigt nun den ausgewahlten SP Simple Portfolio-Inhalt an.

Wie man ubersetzt

SP Simple Portfolio enthalt, wie jede andere Erweiterung auch, .ini Dateien, die alle von
uns verwendeten englischen Begriffe enthalten. In den meisten Fallen mussen Sie nur
diese beiden Dateien ubersetzen:

1. Sprache\de-DE\en-GB.com_spsimpleportfolio.ini
2. Sprache\de-DE\en-GB.mod_spsimpleportfolio.ini

In jedem von ihnen finden Sie Phrasen, die im Frontend verwendet werden, z. B. Alle
anzeigen, Zoom, Beobachten und Anzeigen.

Wichtige Komponentensétze:
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COM_SPSIMPLEPORTFOLIO_SHOW_ALL="Show Al"
COM_SPSIMPLEPORTFOLIO_ZOOM="Zoom"
COM_SPSIMPLEPORTFOLIO_WATCH="Watch"
COM_SPSIMPLEPORTFOLIO_VIEW="View"

Wichtige Modulséatze:
MOD_SPSIMPLEPORTFOLIO_SHOW_ALL="Show All"
MOD_SPSIMPLEPORTFOLIO_ZOOM="Zoom"
MOD_SPSIMPLEPORTFOLIO_WATCH="Watch"
MOD_SPSIMPLEPORTFOLIO_VIEW="View"

Ubersetzen Sie die Zeichenfolgen in Ihre Sprache, speichern Sie sie unter dem Prafix der
Muttersprache und kopieren Sie sie in lhren Sprachordner. Zum Beispiel:

de-DE.com_spsimpleportfolio.ini
de-DE.com_spsimpleportfolio.ini
Dasselbe gilt fur die Modulsprachdatei: de-DE.mod_spsimpleportfolio.ini .

Datei (.ini) muss als UTF-8 ohne BOM-Codierung gespeichert werden. Nachdem die
Phrasen in der Datei Ubersetzt wurden, kopieren Sie lhre Sprachdateien mit einem FTP-
Clientin Ihr Sprachverzeichnis.

Alternative Methode:

Sie kdnnen ausgewahlte Phrasen auch mit der Overrides-Funktion in Joomla: Extensions
> Language Manager > Registerkarte Overrides Ubersetzen.

-4

Users ¥ Menus ~ Content v+  Components v | Extensiong 1 SP Page Builder ~

Help ~

System ~

Manage

™ Languages: Overrides

Modules
E B Edit X Delete | Clear Cache Flugins
Templates
G]
Language(s) Installed
Installed Message E
o ) : Content Languages
Content Languages Language Override was saved : 4
: Overrides h E
. B
Spanish (espafiol) - Site n' Q Clear
[ Constant= Text
E COM_SPMEDICAL_FIELD_VISITING_TIMES Horas de visita
-

I [0 MOD_SPSIMPLEPORTFOLIO_SHOW_ALL Mostrar todo I
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